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1   INTRODUCTION 

OT BioLab+ is an acquisition and processing tool developed by OT Bioelettronica. It is a freeware software 

downloadable at  https://www.otbioelettronica.it/en/downloads in the Downloads section, and tutorials 

are available in the Video → Tutorial section. OT BioLab+ allows to acquire, review and process 

bioelectrical signals detected using the OT Bioelettronica devices listed below: 

 

DUEPRO: is a wearable surface EMG device, records from 2 to 14 channels with 2 auxiliary signals (e.g. 

force, angle).  

 

EMG-USB: surface electromyographic amplifier, up to 128 channels. 

 

EMG-SUB2: surface and intramuscular electromyographic amplifier, up to 256 channels. 

 

EMG-USB2+: surface and intramuscular electromyographic amplifier, up to 256 channels. Each input 

can acquire signals with a different acquisition mode. 

 

FORZA: analog signals amplifier, 1 channel. 

 

MEBA: surface and intramuscular electromyographic amplifier, up to 32 channels. 

 

MUOVI: is a miniaturized wireless and modular HD-sEMG acquisition system directly interfacing with 

laptops, smartphones and tablets, up to 128 monopolar channels (4 probes with 32 channels each). 

 

MUOVI+: is a miniaturized wireless and modular HD-sEMG acquisition system directly interfacing with 

laptops, smartphones and tablets, up to 128 monopolar channels (2 probes with 64 channels each). 

 

SYNCSTATION: is a recharging and synchronization base that allows you to connect 4 Muovi probes, 2 

Muovi+ probes or 2 sessantaquattro and up to 10 Due+ probes. It also allows the acquisition of 3 auxiliary 

signals and a load cell. 

 

QUATTRO: is a portable device for surface EMG data logger that can record up to 37 hours continuously 

the activity of four channels. 

 

SESSANTAQUATTRO: surface and intramuscular electromyographic ad electroencephalographic amplifier 

with Wi-Fi communication, up to 64 channels. 

 

http://www.otbioelettronica.it/
http://www.otbiolab.it/
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QUATTROCENTO: surface and intramuscular electromyographic and electroencephalographic amplifier, up 

to 400 channels. 

 

Using OT BioLab+ it is also possible to review and process any kind of signals stored in txt format. 

OT BioLab+ has been designed for .Net Framework 4.0 and Windows 10 operating both with 32 and 64 

bit.
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2 OT BIOLAB+ INSTALLATION 

 

OT BioLab+ installation procedure requires few minutes and allows to install the software and preinstall 

the drivers for EMG-USB, DUEPRO and QUATTRO. Extract and run the OT BioLab+ setup file. The start-

up window will appear (see Fig. 2.1), the this is the license agreement window, read carefully the license 

condition and click “Next” to continue. 

FIG. 2.1: OT BioLab+ license agreement window. 

 

The next step requires to choose which drivers install (depending on which device you own) (see Fig. 

2.2). Again, click “Next” to proceed.
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Fig. 2.2: OT BioLab+ Custom installation. 

 

It is possible to create a desktop shortcut (see Fig. 2.3). 

                        Fig. 2.3: Desktop Shortcut.
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Now the software is ready to be installed (see Fig.2.4). This window gives a installation summary of the 

components and details. 

 

      Fig. 2.4: OT BioLab+ installation window.
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3 DRIVERS INSTALLATION 

Drivers installation depends on how many drivers you choose to install. 
 
3.1 EMG-USB DRIVERS 

The installation of EMG-USB drivers can be completed just clicking Next on Fig 3.1. After some seconds 

drivers will be installed and you will reach Fig 3.2. 

 

Fig. 3.1: EMG-USB drivers installation window. 
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Fig. 3.2: EMG-USB drivers installed 

 

 

 
3.2 DUEPRO DRIVERS 

In order to use DuePro, some steps are required. These windows open automatically during installation. 

1. Install FTDI CDM Drivers 

Fig. 3.3: FTDI CDM Drivers installer. 
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2. Click “Next” 
 

 

Fig. 3.4: Driver installation window. 

 

 

3. Accept agreement 
 

Fig. 3.5: Driver installer License Agreement. 
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4. FTDI CDM Drivers installed 

 

Fig. 3.6: Driver installation complete. 
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5. Install Texas Instrument drivers. Click “Next” 
 

Fig. 3.7: Texas instrument Driver installation window. 

 
 

6. Accept agreement                   
 

Fig. 3.8: License Agreement window. 

 
 
 
 

 



OTBioLab+ user manual v1.5 

  

17  

7. Install, select the folder and click “Install” 
 

Fig. 3.9: Choose Driver destination folder. 

 
 

8. Open installation folder  
 

Fig. 3.10: Driver installation complete. 
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Fig. 3.11: Driver folder. 

 

9.  Run Setup.exe and click “Next” 

Fig. 3.12: Driver installation. 

 

 

10.  Accept agreement 
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11. Install  

Fig. 3.13: License Agreement. 

 

Fig. 3.14: Choose Driver location folder. 

 

 

12. Texas instrument drivers installed 
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Fig. 3.15: Texas instrument drivers installed. 

 

13. Install Virtual COM port drivers 

 

Fig. 3.16: Virtual COM port installation window. 
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14. Install 

Fig. 3.17: Virtual COM port driver settings. 

 

15.  Open the folder C:\Program Files (x86) 

16.  Go to C:\Program Files (x86)\STMicroelectronics\Software\Virtual comport driver 

 

Fig. 3.18: Virtual COM port drivers location folder. 

 

17.  Choose the right folder. If you have Windows 10, then choose Win8 folder. 

18.  Choose the file depending on your operative system. If your operative system is 64 bits, choose 

dpinst_amd64.exe, otherwise choose dpinst_x86.exe 
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Fig. 3.19: Choose the right file depending on your system. 

 
 

19.  Run it 

 

Fig. 3.20: Virtual COM port drivers installation window. 
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20.  Driver installed 

Fig. 3.21: Virtual COM port drivers installation complete. 
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4 MAIN INTERFACE 
 
Running OT BioLab+ you will meet the main interface, shown in Figure 4.1. 

 

 

Fig. 4.1: OT BioLab+ interface. 

  
The drop-down list of the file toolbar allows you to open, import, save files or close the project. 

Fig. 4.2: OT BioLab+ File toolbar details. 
 

Subject drop-down list lets you manage subject database, adding new subjects or editing them. 

Fig. 4.3: Subject list. 
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Tool let you edit settings, language and theme of the interface. 

Fig. 4.4: Tool list components. 
 
 

View let you change positioning of toolbar or see the abstract of the opened file. 

Fig. 4.5: View options. 
 
 

Acquisition let you to control the acquisition process. 

Fig. 4.6: Acquisition menu, signals acquisition options. 
 
 

 

Help gives information on how/here to find information (tutorial, short cut from keyboard) and send a 

message to the manufacturer. 

Fig. 4.7: Help list, where find information about software. 
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• Send Logger To OT Bioelettronica: opens a preset email to send a message to OT Bioelettronica 
support. 

 

 
Fig. 4.8: Send email to Ot Bioelettronica support. 

 

• Tutorials Online: refers to the tutorials page of the OT Bioelettronica.it website. 
 

• Open Keyboard Shortcut table: opens the pdf file relative to the available shortcuts, shown in table 

9.1. 
 

Extra provides additional data viewing and export options. 

 

Fig. 4.9: Extra options, additional tools. 
 

• About: provides information about the software. 

Fig. 4.10: Informations about OT BioLab+. 

 

• Conversion Factor Calculator: calculates the conversion factor from Volt to the unit of 

measurement entered, the user must enter in the listed below fields the values shown on the 

device (see figure 4.11). 
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Fig. 4.11: Conversion factor calculator. 

• Impedance Controller: when OT BioLab+ is used with the Sessantaquattro device the impedance 

controller it allows to start the impedance test described in section 12. 

• Find Processing: typing part of the processing name allows you to search for available 

processing and tells you where to find them. 

Fig. 4.12: Find processing and its path.  

• Open User Manual: opens the user manual of the installed software version. 

• Open Matlab Code Folder: opens the folder where the sample Matlab files are saved. 
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5 SETTINGS & PRIVACY 
 
Settings form let you control some accessories parameters, like default saving folder, Setup style, Font, 

Privacy, Device Settings or Performance and, also, you can set the automatic software update selecting 

the beta tester checkbox (see Fig. 5.1). 

Privacy let you choose which info you want to share with OT Bioelettronica (Fig. 5.2). Info requested 

are only for statistical reason, to improve OT BioLab+ performance. No acquired data will ever be shared 

with OT Bioelettronica. 

Device Settings allows you to select the desired inputs for each device (Fig. 5.3). 

Performance allows you to disable the track resizing and the tooltip on track (Fig. 5.4). 

Fig. 5.1: Setting window. 

Fig. 5.2: Privacy Settings window. 
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Fig. 5.3: Device Settings window. 

 
 
 

 
Fig. 5.4: Performance Settings window. 
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6 ACQUISITION SETUP 

You can access the device settings window using the appropriate icon, through Acquisition → Setup button 

or with the keyboard shortcut "F1". 

To setup your acquisition, choose your device and sampling frequency. Then the setup window is splitted 

in three parts: 

- Channels: contains the list of selectable channels. 

- Configuration of: keeps track of the configuration assigned to each channel, if already configured, 

if the channel has not yet been assigned it is empty. The push button “Copy in New Channel 

Configuration” allows you to copy that configuration in the section alongside and assign it to 

another channel.  

- New Channel Configuration: you must select the Adapters, Sensor (electrodes), Parameters 

(muscle, side, acquisition mode and filters) and, if you want, the EMG signals Saturation Threshold 

value for your acquisition. To insert the same configuration to multiple channels of the same type, 

enter the number in the "Duplicate n°" box and finally click on "Set configuration as current 

settings". Finally, there are two buttons to delete the configuration from the selected channel or 

from the whole list of channels "Delete sensor at selected point" and "Clear sensor grid", 

respectively. 

- Markers: in the bottom part of the window the user can insert the description of the 5 available 

markers. Each marker is associated to the relative button and can be inserted during the recording 

of a signal acquisition. Accessible buttons are F1, F2, F3, F4 and F5. During a recording, if one of 

those buttons is clicked a marker is set to that specific time. A marker is therefore composed by 

a time instant and a comment. Once the signals has been saved marker are shown on all track 

with a vertical line. Colorsof these lines can be specified under Tool>Settings 

 

When you finish the setup, click on “Setup complete” to save it, see Fig. 6.1. In figure 6.1 is shown the 

SyncStation setup page in which you can select the type of connected devices (Muovi, Muovi+, 

Sessantaquattro and Due+), see the individual user manual for more details, and also the latency (as 

number of packets) that the SyncStation must wait in case one or more connected devices is lagging 

behind the others.  In figure 6.2 is shown the Sessantaquattro setup page in which it is possible to select, 

according to the sensor used in the acquisition, the sampling frequency between EMG (2000Hz) and EEG 

(500Hz) and also the mode between monopolar and differential. In addition, a threshold value can also 

be selected as Saturation Threshold, we can set the value without measurement unit, because it’s referred 

to the data converted by the software and depend on the device connected, so if data are in mV this value 

is compared in mV. It is available for EMG-USB, EMG-USB2, EMG-USB2+, quattrocento and 

sessantaquattro devices. 
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Fig. 6.1. OT BioLab+ Acquisition Setup window with SyncStation device. 

 

 

Fig. 6.1. OT BioLab+ Acquisition Setup window with Sessantaquattro device. 
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If you selected the auxiliary input channels (EMG-USB, EMG-USB2, EMG-USB2+, quattrocento, 

sessantaquattro and SyncStation) it is possible during the Setup configuration to specify the scale factor 

and the corresponding unit of measurement (see figure 6.3). For the calculation of the scale factor, please 

refer to the specific document found on the https://www.otbioelettronica.it/en/downloads website in the 

Download section. 

 

Fig. 6.3. OT BioLab+ Acquisition Setup with auxiliary inputs selection. 

 

In case of auxiliary input setup it is also possible to select the Trigger input. When you select one auxiliary 

channel it is enabled the button “Trigger Settings”, shown in figure 6.4, in which you can choose between 

two different types of trigger: Start rising edge-Stop falling edge and Start rising edge-Stop rising 

edge.  

- Start rising edge-Stop falling edge: triggers the acquisition automatically when the rising edge 

reaches the set Trigger threshold value and stops it at the same value on the falling edge (see 

figure 6.5a). 

- Start rising edge-Stop rising edge: triggers the acquisition automatically when the rising edge 

reaches the set Trigger threshold value and stops it at the same value on the second rising edge 

(see figure 6.5b). 

 

 

https://www.otbioelettronica.it/en/downloads
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Fig.6.4. OT BioLab+ Acquisition Setup with auxiliary input Trigger settings. 

 

 

Fig.6.5. Two different types of Trigger settings. a) Start rising edge-Stop falling edge. b) Start rising edge-Stop 
rising edge. 

 

 

 

a) 

b) 
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In figure 6.6 is shown a real example of signals acquisition in two different Trigger types. In the first 

case, the duration of the acquisition will always be half of the second case. 

 

 
Fig.6.6. Real example of two types of Trigger settings. a) Start rising edge-Stop falling edge. b) Start rising 

edge-Stop rising edge.   
 

 

In case you use the Forza device the setup is like figure 6.4, you have to insert Load Cell Sensitivity 

and Full scale values, that you can find on the load cell itself. 

 
Fig.6.7. OT BioLab+ Acquisition Setup with Forza device. 

 

 

 

a) 

b) 
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7 SIGNAL ACQUISITION 
 

To start an acquisition, click on Acquisition > Start Visualization or click on the Play button on the toolbar 

from the main interface (see Fig. 7.1). 

Fig. 7.1: Strat visualization icon 
 
 

If there are problems with the device or software appears an error message, as you can see in figure 7.2. 

Fig. 7.2: Error message window. 

 

After pressing start visualization, 3 forms are visible: 

1. Main: main interface, where acquired signals are always visible. 

2. Channel List Real Time: a resume list that shows which signals are available and where. 

3. Performances: a chart that keeps the user informed of performances required by the 

acquisition. If it grows too high, there is the risk of acquisition fail and data loss. 

Clicking on Acquisition > Start Recording, a file start being filled with data acquired. Clicking Acquisition > 

Stop Visualization, acquisition will be stopped without saving. Clicking Acquisition > Stop Recording 

acquisition will be stopped and saving process will start (Fig. 7.3). 
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When saving, choose the subject that performed the experiment selecting it from the subject database 

and then save it where you prefer. 

At the end of saving process, acquisition will restart automatically, so, if you want to stop the display and 

exit the process you must click on Stop Visualization. 

Moreover it is possible to define the end of the acquisition process going to set the recording time "End 

process in", at the end of the time the recording is stopped and you are asked to save the data (see in 

Fig. 7.4). 

Fig. 7.3: Visualization and recording window. 
 
 
In the figure below (Fig. 7.4) we can see the buttons available, from left to right: 

• The Start icon to start the visualization 

• The Stop icon to stop the visualization, without saving the data  

• The Pause icon to pause the visualization, in this case, during the acquisition process, the signals will still be 

acquired but the display will be frozen 

• The Acquisition icon to start the acquisition of signals 

• The microSD Acquisition icon to start the acquisition on Sessantaquattro microSD card 

• The Stop Acquisition icon to end the acquisition process and save the data 

 

 
 

Fig. 7.4: Visualization/recording buttons. 
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Figure 7.5 shows the Sessantaquattro microSD card acquisition window, in which it is possible to select the acquisition 
mode and time and the prefix with which the file will be saved on the microSD card and then start the acquisition. 
 

Fig. 7.5: Recording on Sessantaquattro microSD. 
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8 REAL TIME PROCESSING 

 

One of the most important improvements of OT BioLab+ is the introduction of Real Time Processing. 

They can be called from the Real Time Channel List right clicking on the signal of interest and choosing 

the processing you prefer. 

8.1 CLONE TRACK(S) TO 

This processing let you clone the track on another form to have a copy of the signal and see it better. 

Fig. 8.1: Clone track to allow to move the track to another form, for better visualization. 
 
8.2 TRIGGER THIS TRACK 

The trigger real time processing is a visualization tool that let the user see tracks only when they are 

triggered by another acquired signal. 

For instance, it is possible to show tracks only when a signal on the input is high, or when it raises, etc. 

This processing can be applied on every track but can be triggered only by an AUX channel. 

8.3 EEG DISPLAY OPTIONS 

This processing applies a real time high pass filtering at 0.1 Hz to remove the DC from the signal. This 

processing let also apply a real time plug-in changes the acquisition mode from monopolar, detection of signals 

with respect to an electrode positioned in a region of inactivity (e.g. earlobe), to differential, by selecting the 

electrode of the cap with respect to which the differential signal is to be calculated. 
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8.4 RESET SATURATION  

When the signal goes to saturation, exceeds the threshold set in the setup, changes color and turns red, 

this plug-in allows the track to be displayed in the original color, white (see figures 8.2, 8.3 and 8.4). 

Fig. 8.2: Signal tracks under saturation threshold. 

 

 

 

 

 

 

 

 

Fig. 8.3: Signal tracks over saturation threshold, signals became red. 
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Fig. 8.4: To turn white again the signals need to click on Channel List and click on Reset Saturation. 

8.5 ACTIVATION MAP 

Among the “Apply real Time processing” there is the Activation Map processing, is available only for 

matrices 32 or 64 channels and let you see an activation map to identify the zone that is more active. A 

real time barycenter is shown on it. It is possible to change some settings: the type of signal, whether 

Raw or the ARV of the signal, the mode, if monopolar or differential, the color scale with which the map 

is displayed and the range of values, going to set the minimum and maximum value within which the 

activation map will be displayed; based on these changes and on muscle activation the map will take on 

different colors. Refresh epochs are 1Hz, 2Hz or 4Hz. 

 
Fig. 8.5: Activation Map during signals acquisition. 
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8.6 ARV- RMS BAR 

This processing shows the bar chart whose value is the amplitude of ARV or RMS computed on an epoch 

of 62.5 ms (Fig. 8.6). The refresh rate is 16 Hz. 

Fig. 8.6: ARV chart and ARV bar during acquisition. 

 

8.7 ARV – RMS CHART 

This processing shows a chart with the value of amplitude of ARV or RMS computed of an epoch of 62.5 

ms (Fig 8.7). The refresh rate is 16 Hz. 

Fig. 8.7: ARV chart during acquisition. 
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8.8 DIFFERENTIAL 

This processing is available only for matrices 32 or 64 channels, and it is available also during offline 

visualization. This processing will ask to confirm about which is the matrix used for recording and will 

ask the direction of differential. Then it will compute the number of groups to plot (depending on matrix 

and direction) and will fill it with the difference between the correct signals. 

When the direction (horizontal or vertical) is selected, the image is rotated and the arrow corresponding 

to the direction also rotates, and the names of the tracks generated by the plug-in change correctly from 

row to column with respect to the presentation of the image. In other words: 

• when the difference is made horizontally, the groups of traces generated are named as row from 

1 to number of rows; 

• when the difference is made vertically, the groups of traces generated are called col from 1 to 

number of columns. 

Line 1 is the most top, column 1 is the most left. As shown in Fig. 8.8. Therefore, the first channel of 

each group is the difference of the two electrodes in the direction of the arrow. 

 
 

 
Fig. 8.8: Differential plug-in parameter. 
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Fig. 8.9: Differential tracks results. 

 
 

8.9 FFT 

This processing can be applied only to a single signal and shows the Fast Fourier Transform (FFT) over the 

last second acquired (Fig. 8.10). 

Fig. 8.10: Fast Fourier Transform result. 
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8.10 TRAPEZOIDAL FEEDBACK 

The Trapezoidal feedback allows to perform experiments in which we want to record muscle activity during 

tasks. Two types of plug-ins are available, the classic tool and OT Planes which provides the user with a 

video game. It is possible to realize the feedback by recording the EMG activity simultaneously with the 

recording of force signal originating, for example, from a load cell or in general an input signal on the AUX 

or going to record the force feedback on the electrodes themselves. 

8.10.1 CLASSIC TRAPEZOIDAL FEEDBACK 

In case of force signal acquisition, after connecting the device to the AUX inputs of the acquisition system 

and starting the acquisition, it is possible to select the Trapezoidal feedback among the Real Time 

Processing available, as shown in the figure 8.11, by clicking on Apply Real Time Processing > Trapezoidal 

Feedback. 

In case of force feedback, among the Real Time Processing plug-in available for sEMG electrodes it is 

possible select the Trapezoidal feedback, a window, like the one shown in the figure 8.12, appears and 

two electrodes must be chosen from which to calculate the feedback.  

The plug-in will calculate the feedback as the average updated for each new packet sent by the device of 

the differences between the signals detected by the two selected electrodes. Following the choice of the 

electrodes pair, the same window of the first case will open (Fig. 8.13). 

 

Fig. 8.11: Trapezoidal feedback plug-in selection. 
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Fig. 8.12: Selection of the grid channels to make the Trapezoidal Feedback. 
 
 

 
 

Fig. 8.13: Trapezoidal feedback processing start window. 
 
 

In figure 8.13 you can see the yellow dot representing the force indicator in a Chart graph in Voltage (V) 

on Time (s). 

There are two visualization methods: Absolute and Relative scale. 

When the window is opened you are automatically set to Absolute mode, if you first need to register the 

maximum voluntary contraction (MVC) value and then you can switch to the Relative mode. 

So, the check box "Use Absolute scale" is already selected, see figure 8.13, by clicking on the Rec MVC 

button you start recording. 
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After registering the MVC or after manually setting the value, switch to Relative mode (in which the 

displayed value is compared to the indicated MVC) and click on the Settings button to access the window 

shown in figure 8.14 and go to define the path to follow during the task. 

Fig. 8.14: Setting options. 
 

Figure 8.14 shows the menu beside the graph where you can access different display and setting 

options. Below is an explanation for each button. 

• Settings: allows access to the window shows in figure 8.15, in which the path to be followed 

during the task is defined. The path is divided into 5 parts and for each one it is possible to 

define the percentage of MVC to reach and the percentage of error that is considered 

acceptable. In addition, an equal error percentage can be defined for the entire route and 

specific for each portion, enabling or disabling the check button at the top. 
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• Charts: in this section you can decide which graphs to show 

o Bar: clicking on the check box the bar graph is shown on the right side of the form 

o Chart: clicking on the check box shows the main graph in which feedback is represented 

with a yellow dot and, if already set, the task profile to follow 

o Path: clicking on the check box changes the dot color from yellow to blue 

• Parameters: 

o Beep: represents auditory feedback. When the force exerted resulting within the limits 

of the path to follow, is within the percentage of error allowed, nothing is heard, if the 

force is out of this interval a “beep” is heard 

o Offset: it allows to remove the offset of the instrument used for the force measurement 

and this value is represented in the text box next to it 

• Absolute: 

o Use Absolute scale: it is already selected when you open the Trapezoidal feedback 

plug-in and, in this mode, it is possible to record the MVC value or enter it manually 

o Graphs Vertical scale: insert in the text box the maximum value that you want to display 

on the ordinate’s axis of the graph 

o Scaling factor: insert here the scaling factor in case you want to display the values of 

force, for example, in Kg instead of V. The scaling factor to be entered depends on the 

sensitivity of the connected instrument, it is usually indicated in the device user manual 

in V/Kg, in this case the value must be entered in Kg/V therefore 1/sensitivity. After 

that the graph will be scaled accordingly. 

o Unit: enter the unit of measurement of the axis according to the inserted scaling factor 

• MVC: 

o User MVC: the MVC value recorded in Absolute mode will be displayed in the text box 

or this value can be entered manually 

o Rec MVC: the button allows to start the recording of the MVC in Absolute mode 

o Reset MVC: the button allows to reset the value of the MVC 

o MVC/Rest duration: it is possible to enter the duration of the recording of the MVC and 

the duration of the rest period after this acquisition. When the Rec MVC button is 
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pressed the recording time will be displayed and after the indicated period the 

recording will be automatically interrupted. At this point the rest time will be displayed, 

by countdown, but after this period it will be necessary to click again on the Rec button, 

the acquisition doesn’t restart automatically 

• Use Relative Scale: click on the check box to switch from Absolute mode (default) to the 

Relative mode in which it is possible to execute the protocol definable in "Settings" 

• Start protocol: button used to start the protocol during the Relative mode 

• Reset protocol: button that is used to restore the dot to the beginning of the protocol, then 

start again 

Fig. 8.15: Path Setting. 

 

Figure 8.15 shows the "Settings" window in which you can set the parameters of the path to follow. It is 

possible, once all the parameters have been set, to export the drawn path, in a text file, and then to 

import it, any follow the same path in other experiments. Following the path setting the trapezoidal 

feedback graph will change as shown in Figure 8.16. The vertical scale will now represent a percentage 

value with respect to the MVC value recorded previously and when the subject is ready just click on the 

“Start protocol” button to start the protocol section, as shown in figure 8.17. 
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Fig. 8.16: Relative scale mode. 

 

Fig. 8.17: Protocol section in Relative scale mode. 
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Fig. 8.18: Trapezoidal feedback generated tracks. 

 

If you start the Acquisition there will be 4 signals related to the Trapezoidal feedback (see figure 8.18): 

• The first one is the Auxiliary channel used as input for the trapezoidal feedback acquired together 

with the EMG signals at 2048 Hz and amplitude is in Volt. 

• The second one is the same signal as AUX Force, but acquired by the trapezoidal feedback window, 

sampled at 2048 Hz, but with a delay of about 125 ms and amplitude is in Volt. 

• The blue signal is still the force signal but sampled at the refresh rate of the trapezoidal feedback 

window of 16 Hz and the amplitude is in percentage (%) of MVC. 

• The last one is the target signal sampled at the refresh rate of the trapezoidal feedback window 

of 16 H and amplitude is in percentage (%) of MVC. 

8.10.2 OT PLANES 

The video game is available as the classic plug-in on both auxiliary signals and sEMG signals. Unlike the 

classic plug-in, the initial screen is the one shown in figure 8.19 and allows you to set the path to follow 

which will later be represented within the game. At the beginning it is necessary to click on MVC to register 

the maximum voluntary contraction value against which the game will be set (Fig. 8.20). Then clicking on 

play starts the video game in which the subject will have to try to collect the coins that reflect the path 

set in the initial settings (Fig. 8.21). 
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Fig. 8.19: OT Planes initial settings. 

 

 

Fig. 8.20: OT Planes MVC recording. 
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Fig. 8.21: OT Planes video game. 

 

8.11 TRACK HEADER 

In the track header there are several display options available in real time and offline. The toolboxes 

are: 

 

 
Fig. 8.22: Track header options. 

 

•       Zoom In: is used to modify the vertical scale, to zoom in width. 

•       Zoom Out: is used to modify the vertical scale, to decrease in width.      
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•       Autoscale: allows to autoscale the vertical range, using the maximum and minimum values on 

the visualization window of the selected track. In case of grouped track the value shown in 

brackets indicates the vertical distance between two channels (interspace), in case of single track 

is shown the unit of measurement. 

• Set vertical range: allows to define the vertical display scale, you can choose between the display 

of the individual channels spaced by a certain offset, to be set in mV and the display of the 

channels overlapped each other by setting the minimum and maximum value displayed, see figure 

8.23. 

Fig. 8.23: Set vertical range options. 
 

• Set name: with which you can change the header name. 

• Set comments: it is possible to add comments to the tracks. 

• Hide last channel: when viewing the signals acquired in differential mode the last channel is always 

to be discarded, it is therefore possible to hide it, so as not to be confused during the visualization. 

After that it is possible to restore it. 
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• Set color: allows you to change the color of the displayed signals, see figure 8.24. 

Fig. 8.24: Set color option, it is possible to change the signals color, for example in yellow as shown in this 
window. 

• Remove offset: allows you to remove the offset, an option that is especially useful for signals 

coming from the auxiliary inputs 

• Choose channels to plot: this plug-in allows to choose which channels to turn off, not to plot. It is 

available for all types of grids and for EEG headsets. When the window shown in the figure 8.25 

appears, the grid orientation must be selected using the Angle item and the channels must be 

arranged using horizontal or vertical alignment. If you want to plot all the channels just press 

“Select All”, if you don't want to plot any channels press “Unselect All”. If instead you want to 

exclude some channels you need to click on it and the numbering of the remaining channels will 

be scaled. After that click on the “OK” button to return to the visualization mode. 

• Copy/Paste Settings: it allows to copy the settings of a track to another track, without having to 

redo the whole process, but it is possible to copy only some toolboxes: set vertical range, set 

name, set comments, set color, hide last channel. 

• Show Markers: allows you to review the instants of time and comments entered during the 

acquisition and, if necessary, modify them (add, delete, export, import). See figure 8.26 and 8.27, 

in which the window of the markers assigned during the acquisition is shown and from which it is 

possible to modify them. If no marker has been inserted during the acquisition the window will be 

empty. In case of need, marker can however be inserted offline manually. 
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Fig. 8.25: Choose channels to plot toolbox allows to choose which plotting channels, following the switch-off of 

some channels, the others will be scaled accordingly and will always be plotted with numbering starting from 1. 

 

 

Fig. 8.26: Markers assigned during the acquisition. 
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Fig. 8.27: Window relative to the markers in which it is possible to modify, add, delete, export and import them. 
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9 SIGNAL REVIEW 

OT BioLab+ allows to open and review different file types. There are three methods to load a file: using 

the Open function under the File menu, from the Menu toolbar, or using the Import function under the 

same menu and toolbar. The Open method simply opens a new file or several files at the same time, even 

of different types (extension .otb, .otb+, .bio etc). In case of multiple opening the user is asked whether 

to insert the files all in the same form or in different form (Fig. 9.1). If different forms are chosen, they 

will be named Tab1 - RawData, Tab2 – RawData, etc (Fig. 9.2). To have a reference between Tab and 

the original filename, this is present as a tooltip over the Tab (Fig. 9.2). 

Fig. 9.1: Open method in case of multiple opening. 

Fig. 9.2: Multiple opening in case of two files in different forms. 
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Import method keep the currently opened signals and adds the new ones under them. The Import function 

can be particularly useful, for example, when signals recorded using more devices. 

9.1 FILE EXTENSION 

OT BioLab+ can manage different kind of files: 

• otb+: files created by OT BioLab+ containing acquired signals, setup details, subject information, 

processing data and workspace. This format will be used only if the raw data dimension is smaller 

than 400 Mbytes. In case the RAM of the PC is not sufficient to save this amount of data, the files 

can be recovered because saved in.xml format (see below) in the same path previously chosen, in 

a folder named “temp”; otherwise the files are saved in the .otb format and the “temp” folder will 

be deleted automatically. 

• otb: files created by OT BioLab containing acquired signals, setup details, subject information, 

processing data and workspace. Also for these files the same storage rules apply. 

• brx: files generated by bruxoff and containing two EMG signals and one ECG signal. 

• emg: files generated by μEMG  or  μEMG-S and containing a single EMG channel. 

• frc: files generated by P-ForceMet and containing a single force channel. 

• bio: files generated by foremg and containing 4 EMG signals. 

• txt: any text file containing data can be opened. To open it, OT BioLab+ require some details 

regarding the format. For this reason, a Text File Information window appears asking the user to 

choose the decimal separator (dot or comma), the  columns delimiter (semicolon, comma, space or 

tab), the time column or at least the time increment between subsequent lines. When all the 

information are inserted it is possible to open the data. 

In figure 9.3 is shown a file in which the first two rows contain words and not only number so OT 

BioLab+ highlighted this two rows in red because isn’t possible to open it. The user must delete the 

first two rows and then import the file as shown in figure 9.4. 

Fig. 9.3: Multiple opening in case of two files in different forms. 
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Fig. 9.4: Multiple opening in case of two files in different forms. 

In file shown in figure 9.4 the first column is the Time so it’s possible to check the radio button “First 

column is time” and select the time unit of measurement. 

Then select the signals unit of measurement and click on “Ok”. 

• xml:  

- If the file data is larger than 400 Mbytes, due to large acquisition times, a message at the end 

of the acquisition will inform the user that the file has been saved in a different folder (see Fig. 

9.5). In this case it is possible to visualize the data using the OT BioLab+ Open menu window 

also selecting the .xml file format and choosing this file named as the folder name. 

- abstract.xml files are generated by an old generation software called Acquisition Software. It 

does not contain signals but all the information related to the signals acquisition and provide 

links to one or more .sig files containing the data. When opening one abstract file .xml it is 

possible to open one or more related signal files. Several files .xml are generated by OT 

BioLab+, but the open function is reserved to abstract file created by Acquisition Software. 

• nrv: they are files generated by the Nerveana software. 

• pro: they are files generated by processing plug-in. 

 

 

  

 

 

 

Fig. 9.5: Storage message. 
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All files, once opened, can be processed, manipulated and saved as .otb+ file. 

 

9.2 REVIEWING A SIGNAL 

When opening a signal in Review Mode, OT BioLab+ displays a window similar to Fig. 9.6. The tracks 

are displayed in the same way as for Visualization Mode and the same options to manage the tracks are 

available during the review (refer to Tracks options section). 

FIG. 9.6. Screenshot during signal review showing an example of signals. 

 

In figure 9.7 is shown the toolbar above the signals in Review Mode where we can see different options 

to the review of signals.  

FIG. 9.7. Review Mode Toolbar. 

 

 

Epochs 

In Review Mode, the signals are segmented in epochs. The epoch size can be defined by the user in the 

Set Epoch field, in the toolbar. The epoch segmentation is necessary for several processing plug-in. The 

signals can be selected in two ways: a left click on the Sensor name area selects the entire signals, a 

drag through the desired epoch while pressing the left mouse button selects a group of subsequent 

epochs. 

Moreover, it is also possible to select the start and end point of a selection using the text box: Selection 

range Start – End. 
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Edit Toolbar 

When more signals have been detected from a single sensor, they are grouped together by creating a 

multiple track. In Review Mode, it is possible to group and ungroup signals as desired. 

To ungroup signals select a multiple tracks and then press the minus green button on the Edit toolbar 

or select Edit ->Ungroup Selected Tracks from the main menu bar. All the signals related to the original 

sensor will be spitted in single tracks and moved under the last signal, in the bottom part of the OT 

BioLab+ Review window. The name of single tracks will be assigned automatically by keeping the 

enumeration of sensor channels. 

To group together two or more signals select the desired signals and then press the plus green button 

on the Edit toolbar or select Edit ->Group Selected Tracks from the main menu bar. The new multiple 

track generated will be moved under the last signal, in the bottom part of the OT BioLab+ Review window. 

A given track can be deleted if desired, by selecting the track and pressing the Delete red button on the 

Edit toolbar or selecting Edit ->Delete Selected Tracks from the main menu bar. Even if the track and 

related signals are no longer displayed, in any case, the originally acquired data is preserved in the otb+ 

file. 

 

View Toolbar 

The View toolbar and the View menu include several options for the review of signals. The available 

functions are: 

• Zoom In: increases the time view resolution by reducing the time window displayed. This 

function it is also accessible by using the mouse scroll wheel together with the CTRL button. 

• Zoom Out: decreases the time view resolution by enlarging the time window displayed. This 

function is also accessible by using the mouse scroll wheel together with the CTRL button. 

• Zoom to Selection: expand the time selection to fit the full screen. 

• Fit in Window: fits the entire signals to the full screen. 

• Abstract: displays the information contained in the abstract file associated to the file opened. 

The abstract will be open with a template generated in Excel. 

• Search for Abstract: search tool that allows to find a particular file by searching for abstracts 

defined fields. 

Moreover, keyboard shortcuts are available to better visualize the parts of interest, as shown in the table 

9.1. 
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Combination Position Effect 

CTRL + Left click channel list Set Track Size 

Double Click track Set Track Size 

DEL/CANC track Delete Track 

CTRL + mouse wheel everywhere Zoom In/Out 

CTRL + Left click tracks Multi selection 

SHIFT + Left Click Track or track header Multi selection over the tracks  

F11 everywhere Hide/Show toolbar 

F2 everywhere Open Setup 

F5 everywhere Start Visualization 

F6 everywhere Stop Visualization 

F9 everywhere Start Recording 

F10 everywhere Stop Recording 

CTRL + O everywhere Open 

CTRL + G on multi selected track Group them 

CTRL + U on multi selected track Ungroup them 

CTRL + A everywhere Select all tracks 

CTRL + Up everywhere Zoom In 

CTRL + Down everywhere Zoom Down 

CTRL + 0 everywhere Zoom to selection 

A everywhere Move Tracks to the Left 

D everywhere Move Tracks to the Right 

W on selected epochs Zoom 1:1 on selected epochs 

S everywhere Fit in window 

Q everywhere Go to begin track 

E everywhere Go to end track 

CTRL + C everywhere Copy Settings 

CTRL + V everywhere Paste Settings 

 Arrow key LEFT everywhere Move Selection to Left Epoch 

 Arrow key RIGHT everywhere Move Selection to Right Epoch 

SHIFT + arrow key LEFT/RIGHT everywhere Increase Epochs Selection  

Tab. 9.1: Keyboard shortcuts. 
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Multi selection  

Multi selection uses the CTRL button and the left mouse button. 

To select a signal portion it’s necessary to hold down CTRL and at the same time trace the selection on 

the track once the button has been left in the pop-up menu, the number of the selection (Section 1) and 

the start and end time just made will appear. 

To make more selections on the same signal, it’s necessary to always hold down CTRL and select the 

different sections with the mouse, in the pop-up menu all the selections made will appear and by clicking 

on the name you can select the signal on the track and go to see and if necessary change the start and 

end instants (see Fig. 9.8). 

FIG. 9.8. Multi selection with different sections on one track. 

 

To bring the selection to other tracks, you can click on the track header or click on the signal itself.  

Remember: It isn’t possible to make different selections on different tracks, whether it is grouped or 

ungrouped (single). Even if you try to make different selections these are automatically related to those 

made previously (see Fig. 9.9 and 9.10).  

To bring the selection back on all tracks, you can press the Shift button and click on a track header. 
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FIG. 9.9. Multi selection with tree different sections on different tracks. 

 

To modify a selection made, always keeping CTRL pressed, you must go over the selection itself and 

lengthen or shorten it manually or by changing the start and end instants.  

Remember: In case of multiple selections, a selection must always be between the end of the previous 

one and the beginning of the next one, if two selections are crossed, these are modified and a new 

selection is created (see Fig. 9.10). 

To deselect you must press CTRL and click either on the track header or on the signal itself, in this case 

all the selections made are lost. 

The multi selection can be performed on all types of tracks, Group, Ungroup and on Auxiliary input (Fig. 

9.10 and 9.11). 
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FIG. 9.10. Multi selection overall track types. 

 

 

FIG. 9.11. Multi selection on a single track and pop-up menu to identify the section and start/end istants. 

 

Figure 9.12 shows the tab result of the Differential processing applied to the three selections made in the 

grouped signal above.  
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FIG. 9.12. Results of Differential plug-in applied to tree different signal section. 
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Subject Toolbar 

Every signal acquired has to be stored together with subject details. For each subject it is possible to 

create a record containing all the related data. The records are collected into a database. OT BioLab+ 

give the user the possibility to manage different databases. This feature can be useful for privacy aspects 

when more user use the same PC but they don’t want to share the subjects information. 

By default one database is created by OT BioLab+ during installation in a folder managed by the O.S. 

that the user can’t access directly. If the user don’t need more than one database no operation are 

required, automatically the default database is used and all the operation are performed on it. 

Alternatively, under Subjects ->Manage Database it is possible to create a new database or select an 

existing one. The database created by the user can be saved everywhere on the hard drive or external 

memory devices with the desired filename. The extension, by default is .otdb. When a user database is 

selected, OT BioLab+ keep memory of the database even when the software is restarted. In case file 

.otd is removed, renamed or moved from the originally folder, by default the software switch to the 

default database. Subjects can be added to the database at the end of a recording, but it is also possible 

to insert new subjects at any time. In particular, it is possible to add new subjects to the database or 

find and edit the subjects record. Pressing the Add New Subject button in the Subject toolbar, the Subject 

Editor window appears (see Fig. 9.13). All the information related to a subject can be typed, few of them 

are compulsory, and then, pressing the OK button, the subject is added to the database. 

In case some information related to one subject has to be modified, it is possible to search the subject 

into the database, and then edit any desired field. The Find/Edit Subject button on the Subject toolbar 

open the search window. Any parameter of a subject can be used to find its record into the database. 

 

FIG. 9.13. Subject Editor window. It allows to add a new subject to the database or edit the information related 

to an existing subject. 
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9.3 SIGNAL EXPORT 

It is possible to export the signals acquired using OT BioLab+ to use them with different software (e.g. 

Matlab, Excel, LabView etc.). The methods to export the signals is “Selected signal(s)”. 

Using this option, it is possible to export single or multiple tracks, the result of a processing or a subgroup 

of signals acquired. The export can be done using different file type: Binary, CSV, Wav or Matlab files. 

Refer to the following paragraph for further details. 

 

Export binary data 

To use this option, during review, single channels or subgroups of acquired channels can be exported in 

binary data format. To export a .sig file select the desired tracks, choose Export->As binary file from the 

main menu toolbar. All the signals originally acquired and for the entire acquisition time are exported 

together regardless of any applied selection. 

The .sig file exported is a binary file structured as a number of row equal to the number of channels 

acquired (i.e. number of rows occupied by sensors in the setup used during the acquisition) and a number 

of columns that depends on the signals duration. The sample values are signed short in the range -2048 

÷ 2047. 

The following formula can be used to obtain the signals amplitude “x” at the input of the amplifier, given 

each binary value N in the .sig file: 

𝑋 = 𝑁
𝑣𝐴𝐷 ⋅ 1000

2𝐴𝐷𝑅𝐸𝑆 ⋅ 𝐺𝑎𝑖𝑛
[𝑚𝑣] 

 

where: 

• ‘VAD’ is the A/D converter input range in volts 

• ‘ADRES’ is the A/D converter resolution 

• ‘Gain’ is the gain used during the acquisition for the corresponding channel 

• ‘1000’ allow to obtain the result in mV. 

For example, when using EMG-USB, EMG-USB2 and MEBA, the A/D converter input range (VAD) is 5 V, 

the resolution (ADRES) is 12 bits and the Gain for each sensor can be find in the abstract file. Note that 

the gain for AUX channels is 0.5 V/V since the inputs accept -5 ÷ 5V dynamics, but the A/D converter 

input range is 0 ÷ 5V. 
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Export CSV data 

Single channels, subgroups of acquired channels or processing results can be exported in CSV (comma 

separated value) format. To export a .csv file select the desired tracks, choose Export → As .csv file from 

the main menu toolbar. An error will occur if track with different sampling frequency are selected to be 

exported together. 

In case in which only one recording fragment is to be exported, for example from the instant 20 to the 

instant 30 it is necessary to indicate in the “Selection range” Start: 20 and End: 30, as shown in figure 

9.14, after which click on Export → as .csv file.  

After the filename and the position has been selected the Export Settings window is displayed (see Fig. 

9.15) where it is possible to select the type of header and decimal separator. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 9.14: Example of group of tracks export by selecting only a part of the signal of interest, such as circled in 

red from the instant 20 to 30. 

 

Fig. 9.15: Export Settings window. It allows to set the exporting options. 
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The data is exported with signals amplitude estimated by OT BioLab+ representing the input signals at 

the amplifier inputs, taking into account the gain used during the acquisition. By default the time columns 

is added and the measurement units are indicated in the file header. 

Note that it is not possible to export simultaneously different tracks if they has been acquired with 

different sample frequencies. 

 

Export Matlab Files 

Single channels, subgroups of acquired channels or processing results can be exported in as a Matlab file. 

To export a .mat file select the desired tracks, choose Export->As .mat file from the main menu toolbar. 

An error will occur if track with different sampling frequency are selected to be exported together. 

The .mat file exported can be open using Matlab. After the file has been open different variables will be 

added to the workspace: 

• Data: an N-by-M matrix containing the exported data, N is the number of samples exported, M 

is the number of channels exported; 

• Description: an M row vector containing the description of each channel exported; 

• OTBFile: is the path and filename of the .otb file where the data has been exported; 

• SamplingFrequency: is the value of Sampling Frequency in Hz; 

• Time: is an N row vector containing the time instant for each sample of the exported data. 

In the MatLab Codes folder is available a script called “PlotExportedMat.m” that if launched allows you 

to select the exported .mat file and produce a graph of the exported channels versus time.  

 

 
Export WAV Files 

 

Single channels, subgroups of acquired channels or processing results can be exported in as a WAV file. To 

export a .WAV file select the desired tracks, choose Export -> As .WAV file from the main menu toolbar. 

As shown in Fig. 9.16 it is possible to define the gain of the exported signal and set the duration to be 

exported of the signal, consequently the sampling frequency of the exported file is calculated. 

Fig. 9.16: Export WAV Settings window. It allows to set the exporting options. 
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9.4 TRACK HEADER 

it is similar to the real time track header, section 8.11. Is also reported a description of the signal and the 

type of sensor used in the acquisition, but the available tools are the same (Fig. 9.17). 

Fig. 9.17: Track header in reviewing mode. 
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10 SIGNAL PROCESSING 

OT BioLab+ allows to process any kind of signals managed by the software itself (refer to the File 

Extension section). The processing tools are available in Review Mode. Processing functions are 

accessible under the Processing menu or with right click on channel list (Fig. 10.1). 

There are processing plugins that can be only applied to single tracks and other processing can be applied 

both to a single track or to a multiple track (refer to Track Options section). Each processing can use on 

selected range using manually selection or inserting the values in Start and End textboxes (Fig 10.1). 

All the processing tools do not change the recorded signals but generate new tracks under the last 

existing track. 

 

Fig 10.1: List of processing tools. 
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10.1 CLONE TRACK TO 

It allows to clone the track relative to the selected signal to another existing form (or a new one) or to 

bring it back from one form to the main form (Fig. 10.2). 

Fig 10.2: Clone track to another form. 

 

10.2 EEG DISPLAY OPTION 

It is the same processing of section 8.3. It allows to apply a high pass filtering at 0.1 Hz to remove the 

DC from the signal. This processing let also apply a plug-in changes the display signals from monopolar, 

detection of signals with respect to an electrode positioned in a region of inactivity (e.g. earlobe), to differential, 

by selecting the electrode of the cap with respect to which the differential signal is to be calculated. 

10.3 ABSOLUTE VALUE 

The plugin, when applied, simply rectify the signals. 

Practically, it returns a new non-negative signal without regarding to its sign: 

𝐴𝑏𝑠_𝑣𝑎𝑙𝑢ⅇ = |𝑠(𝑡)| 

Where s(t) is the original signal. 

 

 
10.4 ACTIVATION INSTANT DETECTION 

 

This processing tool estimates the muscle on–off timing, based on a physical model of muscle activation 

rather than on a phenomenological one. Muscle activity is recognized based on the presence of MUAPs in 

the surface EMG signal. 

The surface EMG signal is the sum of the MUAP trains. A basic function can be assumed to roughly describe 

the shape of a generic MUAP detected on the skin surface and the train is indicated with MUAPT(t). 

The EMG signal s(t) can therefore be expressed as: 

  

𝒔(𝒕) = ∑ 𝑴𝒋 𝑼𝑨𝑷𝑻𝒋(𝒕) + 𝒏(𝒕) = ∑ ∑ 𝒌𝒋𝒊𝒋 ⋅ 𝒇 (
𝒕−𝜽𝒊𝒋

𝜶𝒋
) + 𝒏(𝒕)        (1) 

 
 



OTBioLab+ user manual v1.5 

  

74  

 

where: 

 

• j indicates specific MU 
• 𝒌𝒋 is an amplitude factor 

• 𝜽𝒊𝒋 are the occurrence times of the MUAPs of the MU 

• 𝜶𝒋 is the scaling factor 

• 𝒏(𝒕) is the additive noise 

 
In the case 𝜶𝒋 = 𝜶0 , ∀𝑗 and n(t) being white noise, one single event is repeating in the signal with a 

known shape and unknown amplitudes and times of occurrence. In this case, the matched filter (CWT) is 

the optimal filter for detecting the presence of a MUAP. 

 
 

𝑪𝑾𝑻(𝒂, 𝝉) =
𝟏

√𝒂
∫ 𝒔(𝒕) ⋅ 𝒘 ∗ (

𝒕−𝝉

𝒂
) ⅆ𝒕

+∞

−∞

      (2) 

where: 
 

• s(t) is the signal to be analyzed 

• w(t) is a prototype function (mother wavelet) 

• 𝝉 is a translation index 

• a is a scale parameter related to the frequency content 
 

The CWT acts as a filter whose impulse response h(t) is equal to w(-t). 

The event detection is applied to the filter (CWT) output and an amplitude threshold function 𝜂(t) is 

defined as 𝜼(𝒕) = 𝐦𝐚𝐱{CWT(𝒂, 𝒕)}, based on the noise level. 

The amplitude M of the maximum of the test function 𝜂(t) within the interval (0 < t < Tnoise), initial period 

in which the EMG activity is not present, is used to set the threshold value as: 

 
𝑴 = 𝒎𝒂𝒙{𝜼(𝒕)}          (3) 

 
 𝒕𝒉 = 𝜶 ⋅ 𝑴      where 𝜶>1      (4) 

 
The revealed vector is set at one for the time periods during which 𝜂(t) exceeds the threshold and zero, 

otherwise. If the SNR is high, the choice of the value 𝜶 is not critical, due to the great amplitude difference 

between EMG signal and noise. If the SNR is low, a low value of 𝜶 becomes a conservative choice. 

After the detection process, events identified and separated by a temporal distance smaller than 125 ms 

are considered as belonging to the same contraction and merged. This value (125 ms) corresponds to a 

global muscular firing rate of eight pulses per second (pps), which is arbitrarily assumed as the lowest 

effective muscle activity. After the merging of activity bursts closer than 125 ms, the detected events 

shorter than 5 ms are attributed to either isolated MUAPs or noise related spikes and disregarded. 

The algorithm is described in the paper: “A Fast and Reliable Technique for Muscle Activity Detection From 

Surface EMG Signals. A.Merlo, D. Farina & R. Merletti, 2003, IEEE Transaction on Biomedical Engineering, 

VOL. 50, NO. 3.” 

 



OTBioLab+ user manual v1.5 

  

75  

When the Activation Instant Detection plug-in is selected, the window shown in figure 10.3 appears. The 

Initial noise section and the Alpha value correspond to the initial interval and the alpha parameter of the 

formulas (3) and (4). While the Minimum size of an inactivity should be greater than 125ms and the 

Minimum size of an activity should be between 5 - 40ms. 

 

 

 Fig 10.3: Activation Instant Detection parameters. 

 

 
 

Figure 10.4 shows the processing result applied to the track above.  

 

Fig 10.4: Activation Instant Detection result. 
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10.5  AMPLITUDE 

This processing tools use some standard amplitude estimators to generate two new single tracks 

containing the results. The estimators are the Average Rectified Value (ARV), the Root Mean Square 

(RMS), the Mean Square, Signal To Noise Ratio and Epoch Average. The resulting tracks generated are 

added under the last existing track. In all cases a value for every epoch is calculated and displayed as a 

point in the middle of each epoch. When the zoom is set to display more epochs, the points are connected 

each other by displaying a line between each adjacent points. 

 

The estimation of ARV (AARV) is obtained for the epoch i using the following formula: 

 

𝐴𝐴𝑅𝑣(𝑖) =
1000

𝑁
∑|𝑥𝑘|[𝜇𝑣]

𝑁

𝑘=1

 

where: 

 

 

- ‘N’ is the number of samples per epoch 

- ‘xk’ is the amplitude of the signal at the input of the amplifier in mV. 

- ‘1000’ allows to obtain the result in μV. 

 

The estimation of RMS (ARMS) is obtained for the epoch i using the following formula: 

 

𝐴𝑅𝑀𝑆(𝑖) = 1000√
1

𝑁
∑ 𝑥𝑘

2

𝑁

𝑘=1

[µ𝑉] 

 
where: 

• ‘N’ is the number of samples per epoch. 

• ‘xk’ is the amplitude of the signal at the input of the amplifier in mV. 

• ‘1000’ allow to obtain the result in μV. 

 

The estimation of Mean Square is obtained using the following formula: 

 

Mean Square =
1

𝑁
∑ 𝑥𝑘

2 [𝑚𝑣]

𝑁

𝑘=1

 

where: 

 

- ‘N’ is the number of samples  

- ‘xk’ is the amplitude of the signal at the input of the amplifier in mV. 
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The estimation of Signal To Noise Ratio is computed as the Ratio between the highest RMS value of the track 

and the lowest one. 

The estimation of Epoch Average is the mean value of each epoch. Graphically, it is represented by a point 

for each epoch. 

 

10.6 Band Pass EEG 

This processing will extract from each signal (each channel) the characteristic 5 bands of the EEG 

signals. Each of them has a specific frequency range, as you can see in the figure below (Fig. 

10.5), and it’s related to a different functional-brain status. In particular, the alfa band it’s the 

oscillatory component ad it’s the ruling frequency in the human EEG. Its power spectrum is 

represented by the following formula: 

 

 

 

Fig 10.5: Band Pass EEG parameters. 
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10.7  CALIBRATION 

This processing plugin can be used to calibrate a signal acquired, for example, using a load cell to obtain 

the trace directly expressed in the correct measurement unit and with the correct scale (Fig. 10.6). 

Moreover, it is possible to remove an offset to obtain the correct zero level. In this case it is necessary to 

choose the “Use the signal average over selected epoch” as function and set B=1000. 

Fig 10.6: Calibration plug-in, window in which set the function constant. 

 

 
 

 
10.8 CONVOLUTION 

This processing performs convolution between two signals in order to recognize the highest cross 

correlation between them and how the shape of one is modified by the other. Once it recognizes it, it 

will shift in time the second signal in order to align them. 

 

Where: 

- f(t) is the first signal 

- g(t) is the second signal 

- τ is a generic time constant 

For doing this process it is necessary to select two tracks because of the convolution’s definition, 

otherwise it will not work. 

 

10.9  CREATE BINARY TRACK 

The processing Create Binary Track allows you to set a threshold: all the values above this threshold will 

be set to 1, the remaining value (which are value lesser than the threshold) are set to zero, or vice versa, 

depending on the ThresholdParameters you choose (Fig. 10.7.a). It could be useful for highlighting 

interesting parts of the signal or eliminating minor parts of the signal (see Fig. 10.7). 
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Fig 10.7: Create Binary Track plug-in. a) Window in which set the function parameter and b) Processing results. 

 

10.10 CONDUCTION VELOCITY ESTIMATION 

This tool has been designed for the estimation of conduction velocity (CV) from single differential signals 

detected by an electrode array. It is possible to use three different plug-ins to estimate the CV. 

The first plug-in that appears in the dropdown menu under “CV Estimation” is named “Conduction 

velocity Phase Delay (3 signals)” and it requires three single differential signals to estimate a CV value. 

The three signals must be three single tracks selected by the user. The tracks can be grouped or 

ungrouped (see section 9.2). In case the user needs to use the “free selection” on tracks it is 

recommended to group tracks to optimize the selection. 

The algorithm calculates two double differential signals from the three single differential signals and then 

estimates the delay between the two signals obtained in a least square sense in the frequency domain. 

For further details on the delay estimation refer to: “McGill K.C., Dorfman L.J. High-resolution alignment of 

sampled waveforms.    IEEE Trans Biomed Eng, BME-31: 462–468, 1984”. 

Once the delay is estimated, CV is obtained dividing the distance between electrodes by the delay 

obtained. The indication of the Inter Electrodic Distance (IED) is first of all searched in the sensor name 

field of the signals, in case it is not found it is asked to the user. 

The track containing the results is added under the last existing track. A value for every epoch is 

calculated and displayed as a point in the middle of each epoch. When the zoom is set to display more 

epochs, the points are connected each other by displaying a line between each adjacent point. 

The second plug-in that it is implemented is based on a different algorithm and is named “Multichannel 

Conduction Velocity”. With this plug-in it is possible to select and use different channels (three or more) 

to estimate the CV. Also, in this case the tracks can be grouped or ungrouped. In case the user needs to 

use the “free selection” on tracks it is recommended to group tracks to optimize the selection (see 

Fig.10.8). 
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Fig. 10.8: Multichannel CV plugin used on grouped signals. 
 

 

This multichannel algorithm estimates the CV in the frequency domain. The algorithm is described in 

the paper: “Assessment of average muscle fiber conduction velocity from surface EMG signals during 

fatiguing dynamic contractions. D. Farina et al, IEEE Trans Biomed Eng. 2004 Aug;51(8):1383-93”, and it 

provides an estimation of the CV from a set of EMG signals in a time interval in which the mean square 

error (MSE) between aligned signals is minimized. The minimization of the MSE function is performed 

in the frequency domain, without limitation in the time resolution and with an iterative computationally 

efficient procedure. The algorithm that is implemented in OT Biolab+ uses a rectangular window with an 

amplitude of unity. This choice was adopted in order to minimize the computational time of the 

algorithm. The CV is calculated for epochs as for the previous algorithm. The track containing the results 

is added under the last existing track. The value for every epoch is displayed as a point in the middle of 

each epoch.  

The third plug-in is named “Windowed conduction velocity” and it allows to calculate the CV at the 

center of a free selection. The signal is windowed in time domain by a Gaussian function. The algorithm 

used is the same of the Multichannel CV, so three or more signals can be selected. In this case it is 

necessary to group the tracks in which the user calculates the CV. Using the free selection, the plug-in 

calculates the CV at the center of the selected time interval as reported in Fig. 10.8. When this plug-in is 

selected, a window will appear to select the desired sigma in milliseconds of the Gaussian window. The 

calculated value is reported in a new track at the center of the selected interval (see Fig. 10.9). 
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Fig. 10.9: Example of a windowed CV calculated with a Gaussian function (sigma of 30 ms). 
 
 
 

10.11  DATA APPROXIMATION 

OT BioLab+ can provide different type of data approximation. In particular, five different tools are 

grouped under the Data Approximation menu voice: average, coefficient of variation, linear, standard 

deviation and parabolic. 

For completeness, in the following lines there are a basic description of the mathematical principles of 

each tool. 

• Average: 

𝐴𝑣 =
1

𝑙ⅇ𝑛𝑔ℎ𝑡(𝑥[𝑖])
∑ 𝑥𝑖

𝑛

𝑖=1

 

Where  

- xi is a component of the vector x[i] of n elements (in fact the operation is integrated in a for 

cycle) 

• Coefficient of variation 

𝐶𝑉 =  
𝜎

𝜇
∙ 100 

Where 

- σ is the standard deviation 

- μ is the mean  
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• Standard Deviation 

𝑆𝐷 = √
∑|𝑥 − 𝜇|2

𝑁
 

Where 

- X is a generic element of the vector 

- μ is the mean  

- N it the length of the vector 

It’s a statistic measure of the amount of variation or dispersion of all the vector’s values resulting 

from the acquisition. 

• The linear and parabolic approximations are two methods that use an affine function to 

approximate the original signal in a simplified way. They are used in the finite difference method 

for solving complicate equation, also in this case of EMG signal acquisition. 

 

The five approximations can be applied at any kind of single track, but they are intended to be applied 

on processing results based on epochs: amplitude, frequency or conduction velocity estimation results. 

When running a data approximation on a track, the software calculates the polynomial curve with the 

desired grade best fitting the data set, minimizing the square error. The polynomial curve obtained is 

superimposed to the track containing the data set and drown in red. The identified coefficients are 

indicated in the sensor name. 

 

10.12  DECOMPOSITION > DECOMPONI 

The plugin, when applied, decompose the grouped signals, only if the length is between 20s and 100s. 

When you select the grouped signals and click on Processing -> Decomposition -> Decomponi, a Settings 

form is displayed (Fig.10.10) in which it is possible to set the parameters of the decomposition algorithm 

and select the channels of the acquisition matrix on which to launch the algorithm, as shown in the 

following figure. After carrying out the processing, a window divided into two parts appears: Motor units 

found and relative Firing rates (figure 10.11). Figure 10.11 shows the Motor Units found in differential 

mode; in the module header it is possible to select the “Monopolar” checkbox to change the display mode. 

As highlighted, the motor units are presented in three different ways:  

- Default: MUs are presented in order in which they are found,  

- SIL: MUS are presented according to the silhouette of the single MU  

- Number of Peaks: MUs are presented according to the number of peaks of each one.  
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It is also possible to select all the approved Motor Units or the single one to be imported in the Main page.  

The last part of window is relative to Firing rate: Innervation Pulse Train IPT and Instantaneous Discharge 

Rate IDR (figure 10.11). 

The buttons on the side allow you to select the activation peaks and eliminate them, figure 10.12, select 

spikes and add these to the peaks highlighted by the algorithm, figure 10.13. Figure 10.14 shows the IDR 

and the two figures IPT and IDR can be placed side by side and by selecting the "Synchronize zoom" 

button it is possible to synchronize the two figures during the zoom and unzoom phases. 

When you click on "Save Only Approved MU", the spike trains of the saved motor units are shown in the 

main window and if the individual motor units are also imported, they are displayed in the main window, 

as shown in figures 10.15 and 10.16. To display them, however, it is necessary to take into account that 

the individual motor units are active in short instants, and it is necessary to modify the time scale and the 

epochs to be able to see them, for example set the duration of the epoch to 0.05s (50ms), figure 10.16. 

 

 
Fig. 10.10: Settings Decomponi algorithm. 
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Fig. 10.11: View and selection of Extracted Motor Units. 

 

 
Fig. 10.12: Innervation Pulse Train IPT. Selection of individual peaks in yellow. 

 

 
Fig. 10.13: Innervation Pulse Train IPT. Selection of individual spikes to add to the peaks. 
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Fig. 10.14: Instantaneous discharge rate IDR. 

 

 
Fig. 10.15: IPT and IDR aligned. 

 

 
Fig. 10.16: Grouped Firing rate signals from approved MUs. 
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Fig. 10.17: Single MUs saved in the Main form.  

 

 

Now, the firing samples and Motor Units tracks can be export as MatLab structure or .csv file.  
 

10.13 DECOMPOSITION > EXTRACT MOTOR UNITS 

This plugin shows the template of the decomposed motor units. To use this plugin, proceed as follows: 

1 Select grouped signals and grouped firing rate decomposition (see figure 10.18). 

2 Run Processing > Decomposition > Extract Motor Units 

3 Choose the right matrix 

4 Choose the orientation 

5 Choose the display time  

Fig 10.18: Double selection of grouped signals. 
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In figure 10.19 it’s displayed the Motor Units extract by the algorithm, and these are representing in 

differential mode. If you want, you can change to Monopolar mode by selecting the checkbox in the form 

header, the Motor Units in monopolar mode are displayed in figure 10.20. If you have not previously saved 

the MUs, it’s also possible from this window to import them into the Main form, individually or all 

simultaneously.  

As you can see from the image below, it is also possible to choose the Motor Unit you want to analyze. 

 

 
Fig. 10.19: Motor Unit extraction result in differential mode. 
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Fig. 10.20: Motor Unit extraction result in monopolar mode. 

 
 
 

10.14  DECOMPOSITION                                                                                                                                                                                                                              >MEAN  FIRING  RATE  

This plugin can be applied to decomposed signals. This plugin draws a curve showing the firing rate of 

motor units during acquisition, related to the number of spikes generated per unit of time. 

To have a best sight of the mean firing rate, please do as follows: 
 

1 Select the grouped firing rate signals 

2 Run Decomposition > Mean Firing Rate 

3 Right click on the mean firing rate signals 

4 Set Vertical Range 

5 Use superimposes channels 

 

 

 
10.15  DERIVATIVE 

Performs derivative of a signal, so it is available only for one track at a time. 

The first derivative of a signal is the rate of change of amplitude with the time, which is interpreted as 
the slope of the tangent to the signal at each point. 

 

 

 

http://en.wikipedia.org/wiki/Slope
http://en.wikipedia.org/wiki/Tangent
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10.16  DIFFERENTIAL 

This processing is available only for matrices 32 or 64 channels, and it is available also during offline 

visualization. This processing will ask to confirm about which is the matrix used for recording and will 

ask the direction of differential. Then it will compute the number of groups to plot (depending on matrix 

and direction) and will fill it with the difference between the correct signals. 

When the direction (horizontal or vertical) is selected, the image is rotated and the arrow corresponding 

to the direction also rotates, and the names of the tracks generated by the plug-in change correctly from 

row to column with respect to the presentation of the image. In other words: 

• when the difference is made horizontally, the groups of traces generated are named as row from 

1 to number of rows; 

• when the difference is made vertically, the groups of traces generated are called col from 1 to 

number of columns. 

Line 1 is the highest, column 1 is the leftmost. As shown in Fig. 10.21. Therefore, the first channel of 

each group is the difference of the two electrodes in the direction of the arrow. 

 
 

 
Fig. 10.21: Differential plug-in parameter. 

 
 

 
10.17 ENVELOPE 

Extract the envelope from a single track and normalize it with respect to the envelope maximum peak. 

The tool has been designed for EMG signals, the resulting signal is obtained by rectifying the desired 

signal and applying a II order Butterworth low pass filter with 5 Hz corner frequency to the rectified 

signal. 
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The frequency response of the II order Butterworth filter is defined as follows: 

|𝐺(𝜔)| =
1

√1 + 𝜔2𝑛
 

Where: 

- 𝜔 is the angular frequency 

- 𝑛 is the order, in this case n=2 

 

Instead, the first order low-pass filter eliminates everything under the frequency of 5Hz, whose Laplace 

transform is: 

𝐻(𝑠) =
𝜔0

(𝑠 + 𝜔0)
 

 

10.18  FFT 

The FFT can be estimated from single tracks on the desired number of epochs. After selecting the track 

a window will appear (Fig. 10.22) for selecting the number of samples that will be used to obtain an 

averaged FFT to reduce the noise in the estimated power spectrum. A minimum of 256 samples for the 

averaged FFT is required. The maximum number of samples is equal to the length of the data. From 

this menu the user can select the window functions to apply to the time domain data for estimating the 

FFT (rectangular, hanning, hamming, blackman). Samples used to obtain the averaged FFT can be 

overlapped (50 % of overlap - Welch’s method) or no overlapped (Barlett’s method) selecting the options 

that appears on the bottom-right of the window menu. After selecting these options a new window will 

display the result of the algorithm (Fig. 10.23). Details about the FFT algorithm can be found at   

http://sourceforge.net/projects/kissfft.  After the FFT has been estimated, keeping the left mouse button 

pressed a rectangular window can be drawn to indicate the area that the user wants to zoom in. When 

a right click on the FFT zoom out will be performed. 

 

Fig. 10.22: Window menu for selecting number of samples. 

http://sourceforge.net/projects/kissfft
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Fig. 10.23: An example of an FFT spectrum obtained averaging 1024 samples is shown. 

 

 

 

10.19  FILTERING 

This processing tool can be applied both to single tracks and multiple tracks. When running it, a request 

of filter type and corner frequencies is displayed. It is possible to choose between different type of filters, 

whose expressions are represented below: 

• Low pass 

𝐻(𝑠) =
𝐾𝜔0

2

𝑠2 + (
𝜔0

𝑄 ) 𝑠 + 𝜔0
2
 

 

• Band pass 

𝐻(𝑠) =
𝐾 (

𝜔0

𝑄 ) 𝑠

𝑠2 + (
𝜔0

𝑄 ) 𝑠 + 𝜔0
2
 

 

• High pass 

𝐻(𝑠) =
𝐾𝑠2

𝑠2 + (
𝜔0

𝑄 ) 𝑠 + 𝜔0
2
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• Stop band 

𝐻(𝑠) =
𝐾(𝑠2 + 𝜔0

2)

𝑠2 + (
𝜔0

𝑄 ) 𝑠 + 𝜔0
2
 

Moreover, the corner frequencies are differently asked depending on the filter type selected. 

The signals generated by the filtering process are added as single or multiple track in the review window 

leaving unaltered the starting signals. All filter types are II order Butterworth filters. 

 

10.20 FIND ZEROES  

This plug-in produces a square waveform with a value equal to 1 where there are zeroes and a value equal 

to 0 where it has found signal. To identify zero value, must find a zero and compare it with the next 10 

samples if they are all zero then score. On the raw signal it is difficult to identify 10 samples equal to zero 

while on the already processed signal it is more performing. 

 

10.21 FREQUENCY 

This processing tool uses two standard frequency estimators to generate two new single tracks containing 

the results. The estimators are the Mean Frequency (MNF) and Median Frequency (MDF). The two tracks 

generated are added under the last existing track. In both cases a value for every epoch is calculated and 

displayed as a point in the middle of each epoch. When the zoom is set to display more epochs, the points 

are connected each other by displaying a line between each adjacent points. The estimation of MNF (fMNF) 

is obtained for the epoch i using the following formula: 

𝑓𝑀𝑁𝐹(𝑖) =
∑ 𝐼𝑘

𝑛
𝑘=0 ⋅ 𝑓𝑘

∑ 𝐼𝑘
𝑛
𝑘=0

[𝐻𝑧] 

where: 

• ‘n’ is the number of frequency bins in the spectrum 

• ‘fk’ is the frequency of spectrum at bin k of n 

• ‘Ik’ is the Intensity of spectrum at bin k of n 

 

The estimation of MDF (fMDF) is obtained by comparing the total signal spectrum intensity divided by 

two with the cumulative intensity (i.e. all the intensity values for frequencies lower and including the 

focal intensity). The lowest frequency retrieving the cumulative intensity bigger than the half total 

intensity is fMDF. 
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10.22 HEART RATE PROCESSING PLUGIN  

It is used to analyse an ECG track and from this graph the trend of the heart rate. This physiological 

parameter is determined by the distance between two consecutive similar events (for example two systoles 

or two diastoles), typically between two QRS complexes.  

The minimum distance between two heart beats is: 

 

𝒎𝒊𝒏_ⅆ𝒊𝒔𝒕𝒂𝒏𝒄𝒆 =
𝟔𝟎

𝟐𝟎𝟎
∙ 𝒇𝒄  

 

The process does not work with a grouped track, so you must select a single track. If the signal is very 

noisy, the processing could detect zero frequency: in this case try to filter the signal before using the 

processing (Fig. 10.24). 

 Fig. 10.24: ECG signal and its corresponding heart rate. 

 

 

 

 

10.23 MAPS 

 

10.23.1 ACTIVATION MAP 

Maps plugin allows show in a 2D plot the matrix signals of 64 electrodes or 32 electrodes with different 

colour scales. 

The maps plugin has been designed to process data acquired as MONOPOLAR signals. After selecting the 

matrix type a new window will appear with the visualization of the colour map. On the left side of this 

window, different options are available in order to change the visualization of the map depending on the 

type of analysis that is chosen (see Fig. 10.25). 
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Fig. 10.25: Visualization of the colour map and of the menu with different options that can be modified. 

 

From the menu map different mode of visualization can be selected: Monopolar, Horizontal differential 

and Vertical differential. With the Monopolar mode, the plot is generated from the original signals without 

additional processing. The Horizontal differential mode allows to perform the difference between 

contiguous electrodes of the monopolar signals from left to right of the matrix rows. The Vertical 

differential allows to perform the difference between contiguous electrodes of the monopolar signals 

from top to bottom columns of the matrix. 

The maps can be displayed with two different options: ARV or RAW data. 

Choosing the ARV option, the software estimates, for each signal, the average squared values over the 

epoch selected in the OT BioLab+ main window (e.g. 0.5 s in Fig. 10.25). A cursor bar in the top of the 

visualization window can be moved to select the colour map at a certain time. A “Play” button in the left 

side of this bar can be used to start an automatic display of the maps during the acquisition time or to 

stop it. 

In the RAW option, the instant values over the acquisition time are used to generate each map. With this 

option it is possible to display the acquired data by showing the propagation of the action potential along 

the muscle fibers. Three different colour bars are available: “Jet”, from blue to red, “Heat”, from black-

red- white and “Bone”, a modified grey scale with a blue colour. 

Four different rotation angles can be chosen: 0, 90, 180 and 270 degrees with respect to the orientation 

that is reported in the left-bottom side with a picture of the selected matrix. The minimum and the 

maximum value of the colour range is reported in μV and can be changed in the menu. These values are 

also updated and reported in the right side of the colour bar. 
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The minimum and the maximum value can be changed only when the check box of the autorange is un-

checked. 

An available option is the export of the barycenter position of the electromyographic activity throughout 

the duration of the recording and in the display selected mode (monopolar or differential), by clicking on 

the “Export barycenter” pushbutton (see figure 10.26) a .csv file is originated which contains for each time 

the coordinates x and y of the barycenter with respect to the size of the matrix. 

Fig. 10.26: Pushbutton for the activation map barycenter export. 

 

 

 

 

 

 

 

 

 

 

Fig. 10.27: Example of activity in the four corners of the matrix with relative value of the barycenter. 

(-100, -100) (100, - 100) 

(-100, 100) (100, 100) 
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Consider the matrix as displayed in OT BioLab+ when the maps are showed (see figure 10.27): 

• Top-left corner has coordinates -100, 100 

• Top-right corner has coordinates 100, 100 

• Bottom-left corner has coordinates -100, -100 

• Bottom-right corner has coordinates 100, -100 

• The center position has coordinates 0, 0 

 

 

10.23.2 EEG ANALYSIS 

EEG analysis plugin allows show in a 2D plot the signals with different colour scales. 

After selecting the grouped signal, a new window will appear with the visualization of the colour map. 

On the left side of this window there are the activation map of the raw EEG signal while the 4 pictures 

on the right are the activation maps divided by bands: alpha, beta, theta and delta (Fig. 10.28). 

 

Fig. 10.28: Example of EEG activity in the five headsets with relative EEG bands. 
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10.24  MAX - MIN AND MEAN 

This processing computes max, min, mean and peak to peak value of the selected signal, and displays a 

window in which these values are. Also, you can click on “Set as scale” and the min and max value are 

set as track vertical range (Fig. 10.29). 

In particular it works comparing all the subsequent points of the selected track (memorized in a vector), 

finding the maximum or the minimum one. The mean is simply obtained as follow: 

𝑚ⅇ𝑎𝑛 =
∑ 𝑥𝑖

𝑛
𝑖=1

𝑙ⅇ𝑛𝑔𝑡ℎ
 

Where n is the number of elements in the vector. 

It is possible doing it only on a single track; indeed this plugin is not applicable on a grouped one. 

 

Fig. 10.29: Results of Max, Min, Mean and Peak to Peak plug-in. 

 

10.25  PSD 

The power spectral density (PSD) can be estimated from single or multiple tracks on the desired number 

of epochs. As in the FFT plugin, after the selection of the track, a window will appear in which you can 

choose the window type (rectangular, hanning, hamming and blackman) and the number of samples, 

from a minimum of 256, that will be used to obtain an averaged FFT to reduce the noise (see FFT plugin 

for details), the window functions and the method (Welch or Bartlett’s method). 
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After selecting options of this menu two plots will show the PSD of the signal in two different units: dB/Hz 

and mV2/Hz. As an example, in Fig. 10.30 a PSD signal is shown in logarithmic scale. 

 

Fig. 10.30: Example of a PSD spectrum obtained averaging 1024 samples of an EMG channel, the plot is reported 

in logarithmic scale. 

 

10.26  QUALITY CONTROLLER BUFFER/RAMP 

These two plugins can be applied only on signals acquired with devices that provide ramp or buffer. They 

show the ramp, or the buffer recorded during acquisition. 

The ramp represents the progress of data transmission: if there are some visible holes, they are linked to 

a transmission failure. But it can be solved eliminating the void and unifying two different parts of the 

signal. 

The buffer signal expresses the percentage of its capacity, filled by acquired data. If there is an important 

increasing, probably the graphic has some peaks, and it means that it is filling over the limit. 

 

10.27  SUM 

This processing tool can be applied to a multiple track or to, at least, a pair of single tracks. Simply it 

calculates, sample by sample, the sum between signals. 

When it is applied to a multiple track, it calculates the sum between all channels associated to the selected 

sensor and retrieve a new single track containing the sum. 

A typical application is the use with signals from an electrode array; the processing calculates the signals 

virtually obtained with multiple inter-electrodic distance. 
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10.28 TIME SHIFT 

This processing will shift the signal in time, and it is applicable only on a single track. When you run this 

processing, it will ask you how many samples you want to shift the signal. If the number is negative, it 

will move the beginning of the signal forward in time, delaying it. If it will be positive, it will remove the 

first part of the signal. 

 

 

 

Fig. 10.31: Time Shift window with the selection of the shift 

 

 

11 MATLAB CODES 

In the installer there are some examples file for MatLab coding. They are available under the path 

C:\Program Files\OT BioLab+\MatlabCodes. 

This folder is protected by Windows, then you will have to copy files under another path in order to edit 

them. 

 

12 EEG IMPEDANCE CONTROLLLER 

EEG impedance controller is a controller for sessantaquattro when used for EEG recording. It shows the 

electrode-skin impedance to let the user understand if the electrode contact is good enough to allow 

reliable recording. On the headset diagram the different electrodes positioned on the head are 

represented by a circle. For each one the electrode-skin impedance value is calculated using the "Lead-

Off Detection" function present in the sessantaquattro ADC converter and a color code is associated to 

this value which varies between red (not good) and green (low impedance), as shown in figure 12.1.  

• Red: greater than 80 kohm 

• Orange: 25-80 kohm 

• Green: less than 25 kohm 
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Fig. 12.1: Example of EEG impedance controller for 64 channels haedset. 

 

 

13 OTCOMM 

All the communication is managed by the library OTComm.dll. It is possible to use it also without using 

OT BioLab+. 

Some examples are available under Matlab codes. 

Documentation for OTComm.dll is available in C:\ProgramFiles\OT BioLab+\Documentation. In order to 

use OTComm, you just need to import OTComm.dll in your project. It is available in the folder C:\Program 

Files\OT BioLab+. 

 

14 PC REQUIREMENTS 

Operative system: Windows 10 Processor: 

Intel i3 2nd generation. Port: USB2.0 and 

Ethernet 

Hard Disk: 500 MBytes for software installation Minimum 

RAM: 2 GBytes 

The minimal PC requirements listed allows the proper acquisition of all 256 channels of EMG-USB2 

equipment (with max sampling frequency 10.240Hz) and a visualization of 16 channels simultaneously. 

The increase of the number of visualized channels can produce a visualization latency or an intermittent 

visualization. 
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15 PROBLEM SOLVING 

A problem for the visualization of sensors in the Setup Editor can occur in case the old version of the 

software has not been uninstalled before the installation of the new software. 

In order to install correctly the new version 1.4.*.*, the old version of the software should be uninstalled 

before, running the unins000.exe file located in C:\Program Files\OTBioLab+. If the problem remains 

after the installation of the new software, the folder C:\ProgramData\OT Bioelettronica must be cancelled 

manually. 
 
Usually C:\ProgramData\ folder is a hidden folder of the Windows operative system and can be shown 

using the procedure of Windows “Show hidden Folders”. 

 

16 OT BIOLAB LIGHT 

OT BioLab Light has been developed in order to let the user acquire using directly from a socket without 

visualizing data in OT BioLab+. It is automatically installed together with OTBioLab+ and can be searched 

in the application bar or in the OTBioLab+ folder. 

Using OT Biolab Light, you can just configure roughly the acquisition and start it. Then you will be able to 

connect using another software that will read the data coming from a socket. Data can be read also from 

another computer available in the same network. OT BioLab Light can be used with these devices: 

• EMG-USB2+ 

• QUATTROCENTO 

OT BioLab Light creates a socket on the localhost on the port 31000. Interface is shown in Figure 16.1. 

If you want to use Quattrocento, you have to set parameters. Clicking on Edit the Figure 16.2 will appear. 

You can set the refresh frequency on the main interface. Refresh frequency is the frequency of data 

available on the socket for the reading. 

To see data, you just need to open the socket and send the start command. When you open the socket, 

you will receive 8 bytes. They are “OT BioLab” written in ASCII code. 

Fig. 16.1: OT BioLab Light interface.
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Fig. 16.2: OT BioLab Light interface. 

 
Detailed command and answers are: 

• startTX: this command starts the communication with the socket. 

• stopTX: this command stops the communication with the socket. Data are provided 

as short in little endian. 

An example of communication is shown in the Matlab Codes folder.
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17 TROUBLESHOOTING 

 

17.23 SESSANTAQUATTRO IS BLINKING 4 TIMES BUT DATA ARE NOT VISUALIZED. 

Solution 1: Windows Firewall. 

Open Windows Defender Firewall with Advanced Security. Select Inbound Rules 

 

Fig. 17.1: Windows Defender Firewall with Advanced Security. 
 

 

Allow all OT BioLab+ Rules 
 

Fig. 17.2: Software rules. 
 

 

To allow them, right click on it, choose Properties and Allow the connection.
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Fig. 17.3: Choose OT BioLab+ property. 
 

 

If there are no OT BioLab+ rules, then you have to create a new rule. 

 
Fig. 17.4: New rules section.
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• Choose Program 
 

Fig. 17.5: Choose Program in Rule Type. 
 

• Browse to C:\Program Files\OT BioLab+\OTBiolab+.exe 
 

 

 

Fig. 17.6: Choose Program path. 
 

• Choose Allow connection 
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• Check all the checkbox (Domain, Private, Public) 

• Give a name to the rule (OT BioLab+) 

• Click finish. 

 

Solution 2: Antivirus. 

If solution 1 does not work, very likely the problem is the Antivirus. In this case try to disable it. 

 

17.24 SESSANTAQUATTRO: DATA VISUALIZED ARE ALL                                  ZEROES. 

In this case, very likely, the ground reference is not well connected. Data are then in saturation and 

resulting data are all zeroes. Please check the setup to control that connections are fine. 

If you choose acquisition as EEG, then, you will be able to see the signals and check if it is a saturation 

problem. 

 

17.25 SESSANTAQUATTRO:          AUTOMATIC            RECOGNITION      FAILED.      CONTINUE? 

 

When this message pops up, it means that the automatic recognition of Sessantaquattro failed. It does 

not mean that you will not be able to connect, but just that you will have to take care of  IP recognition. 

If connected directly to the device’s net, then you can continue without any problem. If, instead, you 

are connected to an external hotspot, then you will have to manually connect to the Sessantaquattro in 

order to let the Sessantaquattro understand which will be the path for OT BioLab+.  In order to manually 

connect to the Sessantaquattro, just connect to the Sessantaquattro IP using a browser. 

From that moment on, Sessantaquattro will look for the Socket generated by your PC. If you do not know 

the IP of Sessantaquattro, you can check on your router administration page or use external software 

like Bonjour Browser. 

 

17.26 DECOMPOSITION FAILED. DID YOU INSTALL THE DRIVERS? 

For the most of Windows 10 it is not necessary to install Microsoft redistributables, but for some pc it 

could be necessary anyway. 

In this case open the folder 

C:\Program Files\OTBioLab+\Drivers\Decomponi and run: 

• vcredist_2013_x64.exe 

• vc_redist.x64.exe 

Then reboot the PC. Now Decomponi should work properly. 
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17.27   DECOMPOSITION 

 
Decomposition fails and show a Message that says the file has not been found. 
 
There are 2 possible reasons: 
 

1. PC is not 64 bits. In this case algorithm cannot be run. 
 

2. Microsoft Redistributables must be re-installed. Please re-install OT Biolab and check 

Decomposition drivers. Then run them when the popup will appear. 
 
If redistributables cannot be installed, please check windows updates and update the computer to the 

newest windows release. Then run again the installer.  

If the problem does not solve itself, please contact OT Bioelettronica customer service. 

 

17.28 DUEPRO 

 

If when running Acquisition with DuePro a Message that says Device not ready appears, then there are 

2 possible reasons: 
 

1. Dongle or Recharge station is not connected to the pc. In this case connect it. 
 

2. Dongle or Recharge station are not recognized by the pc. In this case reinstall OT Biolab and 

check DUEPRO drivers. Then follow instructions at point 3.2 of this Manual. 

 
 

 


